
CorelPHOTO-PAINT Help Contents
Help topics for CorelPHOTO-PAINT are divided into categories represented by the icons below.
To select a category with the mouse, point to its icon then click. With the keyboard, press Tab to highlight the 
category you want then press ENTER. For Help with open dialog boxes click F1. For more information about using 
Help choose Using Help from the Help menu. To return to this screen, select the Contents button at the top of the 
Help window.

    

 CorelPHOTO-PAINT Commands
File Menu Use File menu commands to create new pictures, load and save pictures, 

acquire images, print pictures, select your printer and change printer options, 
specify prepress options, edit tone maps, and exit CorelPHOTO-PAINT.

Edit Menu Use Edit menu commands to correct mistakes, copy or cut to the clipboard or 
to disk, paste from the clipboard or disk, and clear a picture window to the 
background color.

Image Menu Use Image menu commands to retouch, enhance, transform, and manipulate 
pictures or cutouts.

Effects Menu Use Effects menu commands to select and apply various special effects filters 
to your pictures or cutouts.

Mask Menu Use Mask menu commands to manipulate areas of your picture with various 
masking functions.

Display Menu Use Display menu commands to zoom in or out on your picture, change the 
screen layout, hide or show the toolbox, and access the CorelPHOTO-PAINT 
roll-ups.

Special Menu Use Special menu commands to determine color tolerance, select preferences,
and display system info.

Window Menu Use Window menu commands to rearrange CorelPHOTO-PAINT picture 
windows, minimize pictures, change your active picture, and duplicate 
pictures.

Help Menu Use Help menu commands to open the CorelPHOTO-PAINT Help program and 
learn more about commands, procedures, and tools. 

Control Menu Use Control menu commands from the CorelPHOTO-PAINT program and 
picture windows to move, close, restore, and change the size of the window. 
Each picture window Control menu has an additional Image Info command. 



  How to...
· Work with windows
· Use selection tools
· Use display tools
· Paint objects
· Draw objects
· Use filters
· Retouch pictures
· Work with colors
· Manage files



File menu

New Creates a new picture.
Open Loads a picture previously saved to disk.
Close Closes the picture and all its duplicates. If you have made changes to a

picture since the last time you saved, CorelPHOTO-PAINT asks if you 
want to save them.

Save Saves changes to the current picture. The disk file is updated.
Save As Saves a new picture for the first time or saves a picture previously 

saved to disk with a new name or in a new format.
Acquire Image Allows you to choose a source device; acquire an image from a scanner

or other external device, or calibrate a scanner.
Print Allows you to print an image, setup a printing device(s), calibrate a 

printer(s), and choose various printing options. 
Prepress Allows access to the Prepress Tools dialog box to create color correction

circuits.
Edit Tone Map Allows you to edit RGB and CMYK components of an image to create 

custom response curves, and adjust gamma.
Exit Closes the CorelPHOTO-PAINT program. If you have made changes to a 

picture since the last time you saved, CorelPHOTO-PAINT asks if you 
want to save them.



New command (File menu)
To create a new picture:
1.Choose New from the File menu.
2.Enter dimensions for the picture in the Width and Height boxes.
3.Choose the type of Units (inches, millimeters, picas, points, centimeters, pixels).
4.Enter or choose a value for picture resolution.
5.Choose a color format from the Mode drop-down list. (Black and White, 256 Color, 

Grayscale, 24 Bit Color),
The required memory, and available memory values for the picture are displayed.

6.Click OK.



Open command (File menu)
Note: If the file you are opening is too large for your system resources, CorelPHOTO-PAINT 
will display    "not enough memory". The program will continue to try and load the image, 
however only part of the image will be displayed. 

To load a picture from disk:
1.Choose Open from the File menu.
2.Choose a file type from the List Files of Type box.
3.Choose the Drive and Directory you want.
4.Click a file in the File Name list box. 
5.Click Info to view file information such as name, creation date and time, width, height, 

colors, file size, image size, format and subformat.
6.Click Preview to view a bitmap representation of the picture.
7.Click OK. 

You can have up to eight pictures open at the same time.



Save As command (File menu)
To save a picture to disk for the first time or to save an existing picture with a 
new name:
1.Choose Save As from the File menu.
2.Choose a file type from the List Files of Type box.
3.Choose other available options from the File Sub-Format drop-down list if applicable.
4.Choose the Drive and Directory where you want to save the file.
5.Type a name for the file in the File Name box.
6.Check the Backup box if you want CorelPHOTO-PAINT to save a backup copy of the file 

with a $ as the third letter of the file extension.
7.Click OK.



Acquire Image command (File menu)
The Acquire Image command allows you to access external input devices such as scanners 
or video capture boards, without leaving CorelPHOTO-PAINT.

Select Source
To choose a source device:
1.Choose Select Source from the Acquire Image flyout menu. 
2.Click a device name from the Select Source dialog box. The default is the Corel Image 

Source.
3.Click Select.
Acquire
The Acquire command alows you to access and control external input devices.

To Acquire an image:
1.Choose Acquire from the Acquire Image flyout menu to access your scanner.

The Corel Image Source dialog box that is displayed will depend on the type of scanner in 
use. Some scanners will provide more options that are accessed by clicking the Settings 
button. 

2.Click the Prescan button to perform a preliminary scan of the entire image. 
3.Select an area by dragging on the corner handles of the marquee. 
4.Click the Scan button to perform a final scan.
5.Save the file to disk.
Calibrate
Use the Calibrate command to build custom gradation curves to improve / optimize the 
linearity of your scanner. For example, if your scanner creates scanned images that are too 
dark, or lack contrast, you can compensate for this by using a curve that will cause the 
scanner to scan images that are lighter or sharper.

To Calibrate a scanner:
1.Choose Acquire from the Aquire Image command in the File menu. 
2.Scan the calibration strip from the Quick Reference card. This should be scanned as a 24 

bit color image.
3.Choose Calibrate from the Acquire Image flyout menu. The Scanner Calibration dialog box 

is displayed.
4.Choose the New option and click Calibrate to read the scanned file.
5.Click Save to save the curve with a new name and description.



Print command (File menu)
· Print
· Printer Setup
· Calibrate
· Options



Prepress command (File menu)
Use this command to create a color correction circuit used to create color separations. 
An .SMT circuit can be created for different destination printers so that color separations will 
be printed as accurately as possible on that printer. You can use (or modify) the default 
circuit included with CorelPHOTO-PAINT.

Dialog Box Options:
Circuit

Shows the name of the current circuit.

Gray Component Replacement (GCR)
GCR is a technique for removing some or all of the cyan, magenta, and yellow that 
produces the gray component of an image. Drag the tonal range handles on the GCR 
graph up or down to set the desired level. The value at the top of the selected tonal 
range changes accordingly.

Dot Gain
Adjusts halftone dot size to compensate for the dot gain produced by web, offset and 
off-press proofs. Select the option that corresponds to the type of press you plan to 
use.
Select the desired CMYK channel from the Dot Gain list box. You can set the dot gain 
percentage for all four CMYK channels separately, or all at once by selecting Master 
from the list box. Enter the amount of gain for the selected channel in the text box. 
The most typical percentages are between 18% and 24% for web, offset and off-press
proofs alike.

Quality
Determines the quality of the color correction circuit. Choose Better if you are 
creating a preliminary circuit to test with a color swatch from the destination printer. 
This process can take several minutes. Choose Best to create a circuit if the Better 
option is not adequate. This process can take 20 to 40 minutes to create a circuit.

UnderColor Removal (UCR)
UCR uses black to reduce and replace process colors. Select the desired UCR value by
dragging the slide bar or by entering the value in the text box. 
Film, Printer Indicate whether you are ouputting to film or directly to an imagesetter
by selecting Film or Printer.
Black Point Set the desired Black Point value by clicking the up or down arrows or 
by entering the value in the text box. Black point specifies the apparent darkness of 
black. 

Load, Save
Click the Load button to load in a new circuit. 
Click Save if you want to save any modifications you have made as a new circuit.

Calibrate...
Displays the Calibrate dialog box that allows you to match the colors on your monitor to a 
color swatch from a destination printer or imagesetter. Match the six primary colors (CMY 
and RGB) with the equivalent colors on the swatch. Matching them ensures that the colors 
you see on your monitor will look as much as possible like those in your printed output. 



Clicking a color box displays the Color dialog box with controls for choosing colors. 
NOTE: If you work with different CMYK devices (i.e., imagesetter, proof printer, or matchprint
system), you'll probably need to specify color calibration values for each device. 



Edit Tone Map (File menu)
The Tone Map dialog box lets you create gradation curves for scanner input, on-screen 
gamma, output gamma, and image correction. You can edit the curve by moving the handles
(points) with the mouse, or by entering values for each point in the RGB or CMYK Master, or 
by entering a value to adjust Gamma.

Click:
Apply to apply the curve to the current image.
Cancel to close the dialog box without applying the feature.
Load for loading tone map curves.
Save to save the current settings.
Restore to readjust the settings to the default values.
Preview to see the effect of the correction / enhancement on the image before you 
actually apply the effect.
Edit>> for editing points on the tone map grid.
Options for choosing grid options.

Tone Map has a grid for adjusting highlight, shadow, and nine other midtone points in 
between these for either the RGB or CMYK components of the image. At the bottom of the 
dialog box is a slider control for adjusting gamma and balance. The default is balance.

Editing the Tone Map Curve
Choose the RGB option in the Tone Map group box to edit the red, green, blue, and gray 
components at the same time; or, you can edit just one of the components at a time by 
choosing the desired component, such as green. When you choose a particular component, 
the curve for that component appears in the grid. The same procedure is followed for the 
CMYK option.

Options button:
Reset restores original curve settings.
Copy master matches a component color curve such as Green to the RGB curve.
Handles displays small squares on the curve that you can click and drag.
Freehand allows you to click and drag anywhere on the curve.
Gamma allows you to adjust the gamma setting with the slide control.
Grid turns the background grid off and on.



Print command (File menu)
Prints the current image according to the options you specify. 

Page Window
Shows how an image will look when printed. The bounding box surrounding the preview 
image indicates where crop marks will print. You can resize the image by dragging the 
handles around it. To change its position on the page, click anywhere inside the image and 
drag. For more precision, specify values in the Position and Size boxes.
The rulers allow to you judge the relative size and placement of the image. You can change 
the rulers' units by clicking the Units box and selecting a new unit from the list.
NOTE: Changing the image's size and position does not affect the image file, only how it is 
printed.
The active printer and the port it is connected to is displayed in the upper right corner of the
dialog box. If you have other printers installed, you can select the one you want to use from 
the list.

Printer...
Displays a dialog box for selecting printer setup options.

Options...
Displays the Options dialog box with more advanced options for controlling the way 
an image prints.

Color...
Displays the SmartColor dialog box with controls for preparing images for color 
separation.

Location:
Lets you adjust the size and position of an image with numeric precision. NOTE: 
Changing the image's size and position does not affect the image file, only how it is 
printed. Press the Tab key after entering a number in a box.
Left, Top: Adjusts the position of the image on the page. The value in the Left box 
represents the location of the top left corner of the image. The Top value represents 
the location of the top of the image.
Width, Height: Adjusts the size of the image. When you change the value in one 
box the value in the other changes proportionately so that the image's aspect ratio is 
maintained.

Scale:
Click Maintain Aspect to avoid distorting the image when scaling. Specify what 
Units to use, and click Repaint to redraw the preview image.
Fit to Page reduces the image to fit on the size of paper in the printer. Use this 
option to proof large images that exceed the printer's maximum paper size.
Center Image centers the image on the page. If this option is active when Fit to 
Page is selected, it will be grayed out. 

Scale Factor:
Resizes the image when it is printed. Values below 100 shrink the image; values 
above 100 enlarge it. Useful for proofing very small or very large images. 



Print Options dialog box (File menu)
Use this dialog box to specify how your image prints, and to access controls for color 
separations.

References:
Adds standard printers' marks and file information to your image when you check the
appropriate options.

NOTE: For references to appear, the size of the Printable Page (as determined in the Page 
Setup dialog box) must be smaller than the size of the page you are printing on.
Crop Marks prints crop marks on the printed page. If you are printing color separations, the
color, screen angle and density for each page are also printed.
Calibration bar prints calibration bars for each color bar in the image.
Registration Marks prints registration marks on each page. 
Information prints the filename of the image, the screen frequency, and the current date 
and time outside the left margin of the Printable Page. Also includes the color name and 
screen angle when printing color separations.

Print Positive / Negative
Creates a reversed image of the image for printing on an image setter that images 
directly on film. Positive is the default.

Emulsion Up / Down
Select when printing to film if you want the image to print emulsion side down.

Preview Image
Displays the current image in the "page" window or click Display Bounding Box to 
show the outline dimensions of the image on the page.

Separation: (Print grayscale seps / print color seps)
Separate prints each process color component of an image on a separate page.

Destination (File / Printer)
Choose File to create a PostScript file that can be printed from DOS.    When you choose OK, 
a dialog box opens, prompting you to type a filename. Images printed to file always use a 
default screen frequency of 60 lines per inch. If you want to use a different one, specify it 
using the Screen Frequency setting.

Output Curve
Click Enable to allow you to load a (.map) output curve for your printer.

Frequency (lpi)
Determines the halftone screen frequency used to print your image. 

Angles
Enter values for the CMYK separations.

Info 
Click to display information on the current printer.



SmartColor dialog box
Use this dialog box to compare your image with an image that has been adjusted according 
to settings in the current color circuit. Click the Prepress button to access tools for creating 
circuits for color separations.

Dialog Box Options:
Original, Preview
Shows the original unadjusted image on the left and the color-corrected image on the right. 
The name of the circuit used to adjust image appears in the dialog box's title bar.
You can magnify the original and preview images by clicking their respective buttons. Drag 
the box in the Original window to select the area you want to magnify.

Preview
The Preview Grayscale option is available when only one of the four CMYK color boxes is 
enabled. If the the Preview Grayscale box is checked, the image will be displayed in 
grayscale. Check a color, then click the Preview button at the bottom left corner of the 
SmartColor dialog box.

Circuits
Displays dialog boxes for loading, modifying and viewing information on Color Circuits.
Load Allows you to load a color circuit.
Save Allows you to save modified settings as a new circuit. Click the Prepress button 

to access the Prepress Tools dialog box. Modify your settings and create a new 
circuit. Since the Prepress Tools box has been accessed through the SmartColor 
dialog box, the save button is grayed out, and you must return to the SmartColor 
box to save the new circuit.

Info Displays information about the current color circuit.
The Image Processing box allows you to use, and view a gradation curve for printing the 
image on the current printer. Unsharp masking will sharpen the image by a specified 
amount.



Printer Setup command (File menu)
Use this command to select the printer and printer options you want to use to print your 
image.

Dialog Box Options:
Printer
Selects the default printer or a printer listed in the box under Specific Printer. Only installed 
printers appear in the list. You install printers through the Windows Control Panel.

Orientation
Selects the orientation of the printer page. Choose an orientation that matches the 
orientation specified for your image with the Page Setup command.

Paper
Selects the paper size and source. Click on the arrows on the right of the Size and Source 
boxes to see a list of options you can choose.

Options
Displays a dialog box where you can choose default options for the printer you select. For 
more information, choose the Help button after you choose the Options button.



Print Calibrate command (File menu)
If required, you can improve / optimize the linearity of your printer by adjusting the curve in 
the Print Calibration dialog box. It is better to calibrate your monitor first, and then adjust 
the printer so that it matches how the image looks on your monitor. Click Master to adjust 
for all colors, or click Red, Green, or Blue to adjust an individual color.

To calibrate a printer:
1.Load and print the DEFAULT.MAP    output calibration strip.
2.Compare the strip with the blocks on the left side of the Print calibration dialog box and 

change the values in the boxes beside the blocks. You can also click and drag the small 
squares on the curve.

3.  Print the strip again, and continue changing the values until you have a printed strip that 
is very uniform.

4. If you have a densitometer you can examine the strip and enter exact values in the boxes.
5.Create different curves for different effects. Create curves to    produce lighter printouts, or

printouts with more contrast.
6.Click the Save button to save the new curve with a new name and description.
7.Click the Load button to load in other curves.



Edit menu
Undo Cancels changes made since the last time you chose a tool or 

command.
Cut Deletes a defined area and copies it to the clipboard.
Copy Copies the picture to the clipboard.
Paste Select As New Selection to place the contents of the clipboard, 

surrounded by the marquee, in the upper left corner of the picture. 
Choose As New Image to paste the contents of the clipboard as a new
file in its own window.

Clear Clears the picture or selected area to the background color.
Copy To File Copies a defined area to disk.
Paste From File Places a picture saved to disk, surrounded by the marquee, in the 

upper left corner of the picture.



Undo command (Edit menu)
To cancel recent changes:
· Choose Undo from the Edit menu. Use Undo to cancel all changes made since the last 

time you chose a tool or command.
· Use Local Undo to cancel only some changes made since the last time you chose a tool or 

command.



Cut command (Edit menu)
To cut a defined area to the clipboard:
1.Choose a background color from the Color Selection Roll-Up to fill the cut area.
2.Define an area with the Rectangle Selection, Magic Wand, Lasso, or Polygon Selection tool.
3.Choose Cut from the Edit menu; the cutout is replaced by the background color.



Copy command (Edit menu)
To copy a defined area to the clipboard:
1.Define an area with the Rectangle Selection, Magic Wand, Lasso, or Polygon Selection tool.
2.Choose Copy from the Edit menu.



Paste command    (Edit menu)
To paste a cutout from the clipboard:
1.Choose Paste As New Selection from the Edit menu. The cutout appears in the upper 

left corner, enclosed by a marquee.
2.Drag the cutout to move it to another area.
3.Choose a tool or click outside the cutout to paste it.
4.Choose Paste As New Image to create a new file in its own window. The image can then 

be saved to disk with the File Save As command.



Copy To File command    (Edit menu)
To copy a defined area to disk:
1.Define an area with the Rectangle Selection, Magic Wand, Lasso, or Polygon Selection tool.
2.Choose a file type from the List Files of Type box.
3.Choose other available options from the File Sub-Format drop-down list if applicable.
4.Choose the Drive and Directory where you want to save the file.
5.Type a name for the file in the File Name box.
6.Check the Backup box if you want CorelPHOTO-PAINT to save a backup copy of the file 

with a $ as the third letter of the file extension.
7.Click OK.



Paste From File command    (Edit menu)
To paste an image from a file:
1.Choose Paste From File from the Edit menu.
2.Choose a file type from the List Files of Type box.
3.Choose other available options from the File Sub-Format drop-down list if applicable.
4.Choose the Drive and Directory.
5.Type a name for the file in the File Name box.
6.Click OK. The cutout appears in the upper left corner, enclosed by a marquee.
7.Drag the cutout to move it to another area.
8.Choose a tool or click outside the marquee to paste the cutout.



Image menu
Color Brightness and Contrast

Threshold
Gamma 
Hue and Saturation

Sharpen Sharpen
Enhance Detail
Unsharp Mask
Adaptive Unsharp Mask

Smooth Smooth
Soften
Diffuse
Blend

Tone Color/Gray Map
Equalize

Flip
Rotate
Distort
Resample
Resolution
Convert To
Split Channels To
Combine Channels
Info



Using filters
Use filters to enhance images and create special effects in complete pictures or selected 
areas. Filters are only one aspect of image enhancement. CorelPHOTO-PAINT has tools and 
other retouching commands you can use to edit your pictures.
Note:
· the Preview button allows you to view changes to your picture before they are made 

final.
· Use the Local Undo tool to remove changes in smaller areas, along contours, and pixel-by-

pixel.
· Use the Undo command to cancel everything you've done since the last time you chose a 

tool or command. This command also undoes all changes to a mask.
· Some filters such as the Impressionism and Pointillism filters can take a long time. Select a

small area of the picture first. Then you can experiment with different settings before 
trying to alter the entire picture.

· The type of image you are using can determine the effectiveness of a filter. A filter such as
the Outline filter from the Edge flyout menu works properly when the image contains large
areas of spot colors rather than complex images containing many shades of color.

· The effect of a filter such as Adaptive Unsharp Masking may only be apparent in color 
images at high resolutions.

· Many filters will create much more interesting effects in color images as compared to 
grayscale images.



Blend filter    (Image menu)
Use the Blend filter from the Smooth flyout menu to smooth and soften colors, and to make 
more gradual transitions where light areas meet shadows. 

To blend pictures or defined areas:
1.Choose or enter the Blending Amount.
2.Choose Wide Aperture to create a smoother effect.
3.Choose Preview to see the effect then click OK.



Brightness and Contrast filter (Image menu)
Use the Brightness and Contrast filter from the Color flyout menu to lighten or darken a 
picture (brightness), or alter the distinction between light and dark areas (contrast). 
Intensity effects the the brighter areas of a picture by making them brighter or darker.

To change brightness or contrast, and adjust intensity in pictures or defined 
areas:
1.Enter or choose the amount of brightness, contrast, and intensity you want. The greater 

the number, the greater the effect. As a rule of thumb, increase contrast about one tenth 
the amount you increase brightness. Intensity is applied in greater measure to brighter 
parts of an image. 

2.Choose Preview to see the effect then click OK.



Equalize filter (Image menu)
Use the Equilize filter from the Tone flyout menu to redistribute shades of colors. Equalize 
makes the darkest colors black and the lightest colors white and stretches the colors in 
between. The histogram that is displayed, represents the shades in the image. The height of 
each bar shows the number of dots with that amount of shading. The bottom of the 
histogram shows the range of shades in your picture. 
It is often best to equalize a scanned image first to improve its appearance before using 
other filters. 

To equalize pictures or defined areas:
1.Click the Preview button to see the effect of the default settings. These generally provide 

good results.
2.Click and drag the arrows below the histogram to adjust the Low, Mid, and High values.

· Shades to the left of the Low arrow are black.
· Shades to the right of the High arrow are white.
· Highlights are the shades between the High and Mid values.
· Shadows are the shades between the Low and Mid values.
· Choose Restore if you want to return to the original values.

3.Choose Preview to see the effect then click OK.



Color/Gray Map filter (Image menu)
Use the Color/Gray Map filter from the Tone flyout menu to adjust lighting inaccuracies in 
your image. 

To apply the Color/Gray Map filter:
1.Choose a Preset option, and CorelPHOTO-PAINT automatically adjusts your picture.
2.Choose colors to change from the Channel drop-down list. All adjusts all the colors in the 

picture and is the only channel available for grayscale pictures. Choose a single color 
channel to create special effects or to adjust color balance in your image.

3.Choose a Style to make other changes.
Curve: Smooths distribution and fine-tunes other Styles. Click the handles on the curve in 
the sample box and drag to adjust the curve.
Freehand: Allows you to draw any shape you want in the sample box. Click the curve and 
drag to adjust the curve.
Linear: Allows you to adjust brightness and contrast of a channel. Click the handles on 
either end of the line in the sample box and drag to make adjustments.
4.Choose Preview to see how changes may alter your picture. Choose Restore to return to 

the original values.
5.Choose OK.



Sharpen filter    (Image menu)
To sharpen pictures or defined areas:
1.Enter or choose the amount of sharpening.
2.Choose Wide Aperture for greater sharpening.
3.Choose Preview to see the effect then click OK.

Related Topics
Freehand Sharpen tool



Flip command (Image menu)
Use the flip command from the Image menu to flip a picture or defined area vertically or 
horizontally.



Convert To command (Image menu)
To convert a picture to another color format:
1.Choose Convert To from the Image menu. 
2.Choose the color format:
Black and White [1-bit] Converts the picture to black and white. Choose Line Art if you 

do not want a halftone applied. Choose Printer Halftone to use a
fatting halftone, or choose Screen Halftone to use a diffused 
halftone.

Grayscale [8-bit] Converts the picture to grayscale.
256 Color [8-bit] Converts the picture to 256 colors. 
True Color [24 bit] Converts the picture to 24 bit color.
3.The converted picture is loaded into a window named NEW. Use the    Save As command 

from the File menu to save the converted picture.



Rotate (Image menu)
To rotate pictures or defined areas:
Choose Rotate 90° clockwise, 90° counter clockwise, or 180°.
Use the Custom command to enter or choose any rotation amount. Click the box to 
maintain the original image size. Custom will rotate the whole image, not a selected area. A 
new image will be created in a new window. Use the Save As command from the File menu 
to save the image with a new name or format. 
Use the Free Rotate command to rotate a selected area or the whole image. Click and drag
a corner handle to determine the amount of rotation. Click and drag the small circle if you 
want to change the center of rotation.



Resolution (Image menu)
The resolution command allows you to specify a resolution in dots per inch for your image. 
This information will be retained when the image is saved and will effect the printed output.

To adjust picture resolution:
1.Choose or enter a value in dots per inch.
2.Click OK.



Distort (Image menu)
The distortion command allows you to select an area and transform it into different shapes.

To distort an image:
1.Define an area with a selection tool. 
2.Click a corner of the marquee box and drag it to form the shape you want.
3.  Click outside the selected area to paste the distorted shape.



Resample (Image menu)
The Resample command displays the Resample Image dialog box for creating a new image 
of a different size and/or resolution. Adjust the width and height of the image by size or 
percentage. The units of measurement are in pixels. 

Dialog Box Options:
The Original Image Info box displays the width, height, and size of the original image and 
the Resample Image Info box displays the width, height, and size of the new image.
Enter or choose a width for the new image in the Resample by size box or the Resample 
by percentage box. Changes made in one box will be reflected in the other box. If the 
Maintain Aspect box is checked, the height will automatically change as the width 
changes. Click the maintain aspect box to deselect it if you want to enter values for the 
Height yourself.
Specify the Resolution (DPI) for the image. This will effect the output process, not how the 
image will look on the screen. This translates pixels into inches for printing.
Choose an option in the Process box:

Stretch creates a rougher image by stretching duplicated pixels.
Antialias removes jaggies from the original image.
Average creates a smooth picture by averaging duplicated pixels. 
Truncate creates a rough resampled image by eliminating overlapped pixels.



Split Channels To (Image menu)
Use the Split Channels To command to separate an image into channels corresponding to 
the different components of each color model (RGB, HSV, HLS, CMYK, YIQ). Each channel can
then be edited without affecting another channel. When you split an image a new grayscale 
PCX file is created for each component.

You can save each channel as a separate file in various other formats (BMP, TGA, TIFF). You 
can also modify a selected channel with various filters or tools, and save it as a new file.



Combine Channels (Image menu)
Use this comand to recombine an image that has been split. 

To combine channels:
1.Split an image using the Split Channels To command in the Image menu. In this example 

the image will be split into the RGB components.
2.Edit one or all of the split images.
3.Click the Combine Channels command in the Image menu.
4. In the Combine dialog box, the three component files are displayed in the Source Images 

box.
5.Verify that the image files displayed in the Destination Image box correspond to the 

correct channels in the Channel box. For example, the BLUE.PCX file should appear beside 
the B channel.

6.Click OK to combine the component images into a new PCX file.
You can also reassign the channels to different destination files to create unusual special 
effects when the components are recombined. A different color correction circuit can be 
loaded in the Circuits box.



Threshold filter (Image menu)
Use the Threshold filter from the Color flyout menu to gradually darken an image. RGB 
component values below the threshold will become 0. Component values above the 
threshold are not altered. For grayscale images, pixels below the threshold value become 
black, lighter shades remain unaltered.

To adjust the threshold:
1.Click the slide control to specify the desired threshold value. 
2.Choose Preview to see the effect then click OK.



Gamma filter (Image menu)
Use the Gamma filter from the Color flyout menu to enhance detail by adjusting middle 
grayscale values (mid tones). This will not affect shadow areas (darkest black areas), or 
highlight areas (lightest white areas). 

To adjust Gamma:
1.Click the slide control to specify the desired value. 
2.Choose Preview to see the effect then click OK.



Hue and Saturation filter (Image menu)
Use the Hue and Saturation filter from the Color flyout menu to adjust Hue (a particular color) and 
Saturation (amount of that color) without affecting brightness. 

To adjust the Hue and Saturation:
1. Click each of the slide controls to specify the desired values. 
2.Choose Preview to see the effect then click OK.



Enhance Detail filter (Image menu)
Use the Enhance Detail filter from the Sharpen flyout menu to analyze values of pixels of 
similar color shades to determine which direction to apply the greatest amount of 
sharpening. 

To sharpen areas of similar color:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Unsharp Mask filter (Image menu)
Use the Unsharp Mask filter from the Sharpen flyout menu to accentuate edge detail as well 
as sharpening a certain amount of smooth areas in the image. 

To sharpen with Unsharp Mask:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Adaptive Unsharp Mask filter (Image menu)
Use the Adaptive Unsharp Mask filter from the Sharpen flyout menu to accentuate edge 
detail without affecting the rest of the image or defined area. 

To sharpen with the Adaptive Unsharp Mask:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Smooth filter (Image menu)
Use the Smooth filter from the Smooth flyout menu to tone down differences in adjacent 
pixels resulting in only a slight loss of detail. 

To smooth a picture:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Soften filter (Image menu)
Use the Soften filter from the Smooth flyout menu to smooth and tone down harshness 
without losing detail. 

To soften a picture:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Diffuse filter (Image menu)
Use the Diffuse filter from the Smooth flyout menu to scatter colors and add a fuzzy look to 
an image or selected area. 

To smooth a picture:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Info (Image menu)
The Info command displays image information such as, name, width, height, number of dots 
per inch for the X and Y axes, image type, image size, format, and subformat. Click OK to 
clear the dialog box from the screen. 



Color models
CorelPHOTO-PAINT can split channels for five different color models: CMYK (cyan, magenta, 
yellow, black), RGB (red, green, blue), HSV (hue, saturation, value), HLS( hue, lightness, 
saturation), or YIQ (luminance, chromaticity).

CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.

RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 

HSV (HSB) Model
The HSV model, creates color by varying three parameters: hue, saturation and value 
(brightness). Hue refers to the quality which makes a particular color different from another. 
Blue, red, and green, for example, are all hues. Saturation refers to the purity or intensity of 
a color. By varying the intensity, you can make the color lighter or darker. Value refers to the
percentage of black in a color, where 0 percent is black and 100 percent is white. Value 
(Brightness) refers to the perceived intensity of a self-luminous object.

HLS Model
HLS refers to Hue, Lightness, and Saturation. Hue refers to the quality which makes a 
particular color different from another. Blue, red, and green, for example, are all hues. 
Lightness is the perceived intensity of a reflecting object. Saturation refers to the purity or 
intensity of a color. By varying the intensity, you can make the color lighter or darker.

YIQ Model
YIQ is the color model used in television broadcast systems (NTSC). Only the Y component of
this color model would be seen on black and white television systems. The Y component of 
this splitting process produces a grayscale image that is often superior to results obtained 
with a grayscale conversion using the Convert To command from the Image menu.    The Y 
component is luminance, and chromaticity is encoded in the I and Q components.



Effects menu
These filters can be applied to both pictures, and cutouts.

Artistic Pointillism
Impressionism

Edge Edge emphasis
Edge detect
Contour  
Outline

Emboss  
Invert
Jaggy despeckle
Motion blur
Noise Add noise

Add more noise
Remove noise
Maximum
Median
Minimum

Pixelate
Posterize
Psychedelic
Solarize



Add Noise    (Effects menu)
Use the Add Noise filter from the Noise flyout menu to create a granular effect that adds 
texture to a flat or overly blended picture.

To add texture to a picture or defined areas:
1.Enter or choose a number to specify the amount of texture you want. The higher the 

number, the more granular the effect.
2.Choose Flat or Bell Curve from the Distribution drop-down list. Flat shows more 

pronounced changes than Bell Curve.
3. Choose the color channel you want to affect. All adjusts all the colors in the picture. 

Single is the only channel available in Grayscale.
4.Choose Preview to see the effect then click OK.



Jaggy Despeckle    (Effects menu)
The Jaggy Despeckle filter scatters colors in a picture. This creates a soft, blurred effect.

To scatter colors in pictures or defined areas:
1.Enter or choose Height and Width values to specify the amount of diffusion you want.
2.Click Allow Color Shift (color images only) to introduce new colors into the picture.
3.Choose Preview to see the effect then click OK.



Edge Detect    (Effects menu)
Use the Edge Detect filter to add different outline effects to a picture. 

To enhance edges to create an outline effect in pictures or defined areas:
1.Enter or choose a sensitivity value. The higher the number, the more edges are enhanced.
2.Choose the color you want for the non-outlined areas from the Color drop-down list.
3.Choose a style for the color of the outline from the Edge drop-down list. To automatically 

adjust the outline, choose Auto. For a grayscale picture, choose Light for white outlines or 
Dark for black outlines. For a 24 bit color picture, choose Light for light colored outlines or 
Dark for dark colored outlines. 

4.Choose Preview to see the effect then click OK.



Emboss    (Effects menu)
Embossing creates a three-dimensional relief effect. Directional arrows point to the location 
of the light source and determine the angle of the highlights and shadows.    

To emboss pictures or defined areas:
1.Click a Direction button to specify the location of the light source.
2.Choose a color from the Emboss Color drop-down list to determine the overall color of the 

embossed image. A medium grayish color provides the best results. The embossing will 
make the picture appear in relief.

3.Choose Preview to see the effect then click OK.



Invert    (Effects menu)
To invert the colors in pictures or defined areas:
· Choose Invert from the Effects menu. The colors will be inverted as on a photographic 

negative.



Motion Blur    (Effects menu)
Motion Blur creates the impression of movement in a picture. The higher the speed number, 
the more blurring is applied.

To add a motion effect to pictures or defined areas:
1.Click a Direction button to indicate the direction of movement.
2.Use the Speed control bar to specify the amount of blurring.
3.Choose Preview to see the effect then click OK.



Outline    (Effects menu)
To outline shapes in pictures or defined areas:
1.Choose Outline from the Effects menu.
2.Objects of solid color will be outlined with the color of that object. The inside of objects 

and the background areas of the picture will be filled with a gray color.



Pixelate    (Effects menu)
The Pixelate filter adds a block-like appearance to the picture. You can vary the block shape 
and the size of the blocks.

To create block-like effects in pictures or defined areas:
1.Enter or choose    Width and Height values to specify the size of the blocks.
2.Choose Preview to see the effect then click OK.



Psychedelic    (Effects menu)
To randomly change colors to create a 1960s pyschedelic look in pictures or 
defined areas:
1.Click and drag on the slide control to choose a filtering amount.
2.Choose Preview to see the effect then click OK.



Pointillism    (Effects menu)
Use the Pointillism filter from the Artistic flyout menu to add a dot-like appearance to the 
picture. The effect can be subtle, retaining the overall appearance of the original picture, or 
you can vary the dots and the colors to create very unusual special effects. 

To create a pointillist effect in pictures or defined areas:
1.Choose a dot size.
2.Choose the number of dots.
3.Click and drag the slide controls to choose size variation, dot spacing, and color variation. 

Slide the control farther to the right for a more pronounced effect.
4.  Choose Preview to see the effect then click OK.



Solarize    (Effects menu)
The Solarize filter allows you to choose how much a picture will look like a negative 
photographic image. The effect will be more pronounced in color images.

To produce a selective reversal (negative) effect in pictures or defined areas:
1.Set the threshold level to determine which pixels are reversed. Pixels below the set value 

are reversed.
2.Choose Preview to see the effect then click OK.



Impressionism    (Effects menu)
Use the Impressionism filter from the Artistic flyout menu to give a picture the look of an oil 
painting. The effect can be subtle, retaining the overall appearance of the original picture, or
you can vary the brush shape, brush direction, stroke length, number of brushes, and colors 
to create a very unusual look. Select a small area of the picture to experiment with first, 
since this filter can take a considerable amount of time. Pictures with large, clearly defined 
objects, work well with this filter. Dark, blurred pictures, will produce varied results.

To apply impressionist style brush strokes to objects in pictures or defined areas:
1.Choose a brush shape and stroke direction. A custom stroke style can be created in the 

box by clicking and dragging the dots on the line.
2.Choose or enter a value for stroke length, brush size, and the number of brushes.
3.Click and drag the slide controls to choose size variation, stroke spacing, and color 

variation. The farther the control is dragged to the right, the greater the effect.
4. Choose Preview to see the effect then click OK.



Edge Emphasis    (Effects menu)
Use the edge emphasis filter to highlight edges among areas of different colors and shades.

To specify the amount of edge emphasis in pictures or defined areas:
1.Click the slide control to specify the percentage. The higher the value, the greater the 

effect.
2.Choose Preview to see the effect then click OK.



Contour    (Effects menu)
Use the contour filter to outline the edges of an image. 

To outline the edges of an image:
1.Click and drag the slide control to specify the edge threshold.    
2.Choose Preview to see the effect then click OK.



Add More Noise    (Effects menu)
Use the Add More Noise filter from the Noise flyout menu to create a granular effect that 
adds texture to a flat or overly blended picture. Choose a Uniform, Gaussian, or Spike 
method.

To add more texture to pictures or defined areas:
1.Choose a method to specify the amount of texture you want.

Uniform for an overall grainy appearance.
Gaussian for a heavier, larger grain size for the texture. 
Spike for a thinner, lighter colored grain.

2.Click and drag the slide control to specify the Noise Level percentage. 
3.Choose Preview to see the effect then click OK.



Remove Noise    (Effects menu)
Use the Remove Noise filter    from the Noise flyout menu to soften edges and reduce the 
speckled effect created by the scanning process. Each pixel is compared to surrounding 
pixels and an average value is computed. 

To remove noise:
1.Click and drag the slide control to specify the maximum value permitted above the 

average value. Any pixel above this value will be modified. 
2.Choose Preview to see the effect then click OK.



Maximum    (Effects menu)
Use the Maximum filter from the Noise flyout menu to lighten an image by adjusting pixel 
values to decrease the number of colors. 

To use the maximum filter:
1.Click the slide control to specify the amount of filtering. The larger the percentage value, 

the lighter the image. 
2.Choose Preview to see the effect then click OK.



Median    (Effects menu)
Use the Median filter from the Noise flyout menu to remove noise from scanned images that 
have a grainy appearance. 

To use the median filter:
1.Click the slide control to specify the desired percentage. 
2.Choose Preview to see the effect then click OK.



Minimum    (Effects menu)
Use the Minimum filter from the Noise flyout menu to darken an image by adjusting pixel 
values to decrease the number of colors. 

To use the minimum filter:
1.Click the slide control to specify the amount of filtering. The larger the percentage value, 

the darker the image. 
2.Choose Preview to see the effect then click OK.



Posterize    (Effects menu)
Use the posterize filter to remove gradations creating areas of solid colors or gray shades. 

To posterize a picture:
1.Click the slide control to adjust the number of gray or color channels. The lower the value, 

the more pronounced the poster effect will be. 
2.Choose Preview to see the effect then click OK.



 CorelPHOTO-PAINT tools
Use tools to create and add special effects, retouch, or manipulate pictures and cutouts. 

Selection Tools:
Rectangle Selection defines rectangular areas.
Magic Wand defines areas with similar colors.
Lasso defines irregular areas.
Polygon Selection defines polygonal areas.
Display Tools:
Zoom changes the magnification of a picture.
Locator displays selected area in all windows that contain the same duplicated pictures.
Hand moves your picture vertically, horizontally, or diagonally.
Painting Tools:
Paintbrush creates brush strokes like those made with a standard art paint brush.
Artist brush creates varied brush strokes similar in style to those in oil paintings.
Impressionist brush creates groups of brush strokes of different size, color or direction.
Pointillist brush produces groups of dots of different size and color.
Airbrush shades areas with a soft spray.
Spraycan splatters colors over an area.
Flood Fill tool fills enclosed areas with color.
Tile Fill tool fills enclosed areas with a repeating tile pattern.
Gradient Fill tool fills enclosed areas with a gradient.
Texture Fill tool fills an enclosed area with a custom texture.
Clone paints one area of a picture with a copied area from the same, or different picture.
Impressionist Clone paints one area of your picture with an impressionist brush stroke made up of colors 

cloned from another area.
Pointillist Clone paints one area of your picture with groups of dots made up of colors cloned from 

another area.
Drawing Tools:
Line draws single or joined lines.
Curve draws single or joined curves.
Pen draws shapes.
Text adds text to your picture.
Hollow Box draws hollow boxes.
Hollow Rounded Box draws hollow rounded boxes.
Hollow Ellipse draws single or concentric hollow ellipses or circles.
Hollow Polygon draws hollow polygons.
Filled Box draws filled boxes.
Filled Rounded Box draws filled rounded boxes.
Filled Ellipse draws single or concentric filled ellipses or circles.
Filled Polygon draws filled polygons.
Retouch Tools:
Freehand Contrast tool adjusts contrast locally.
Freehand Brighten tool changes the intensity of colors.
Freehand Tint tool changes color shades.
Freehand Blend tool smooths areas.
Freehand Smear tool smears colors.
Freehand Smudge tool smudges colors.
Freehand Sharpen tool sharpens colors.
Eyedropper selects a color from the picture.
Local Undo undoes the last operation done to an area.
Eraser erases areas of your picture with the background color.
Color Replacer replaces the outline color with the fill color.



Choosing tool colors
Choose the outline, fill, and background colors for your picture in the Color Selection Roll-Up 
located in the Display menu. The To and From colors for a gradient fill are also chosen from 
the Color Selection Roll-Up when the Gradient Fill tool is active.
Use the Eyedropper tool to pick up a color from your picture. Point to a color and click the 
left mouse button to choose the outline color, or the right mouse button to choose the fill 
color, or press Ctrl and click the left or right mouse button to choose the background color. 



Changing your tool size and shape
Use the Tool Settings Roll-Up in the Display menu to change the width and shape of tools.

To change your tool size and shape:
· Enter or choose a value, (maximum 40), in the Width box to adjust the tool size.
· Click the shape button that you want.



Zoom tool -- Zooming in and out
To change the magnification of a picture:
1.Click the Zoom tool.
2.Point to the area you want to zoom.
3.Click the left mouse button to zoom in.
4.Click the right mouse button to zoom out.
5.Continue clicking the mouse button to cycle through the Zoom command percentages. 

Double-click the Zoom tool to quickly return to 100% view.
· To see changes occur in other zoom views, duplicate the picture with the Duplicate 

command in the Window menu, and adjust the zoom levels. Use the Locator tool to display 
the same area in all copies.



Hand tool -- Moving areas of your picture into view
The hand tool is used to move areas of a picture into view if the picture is larger than the 
display window. 

To move your picture with the Hand tool:
1.Click the Hand tool.
2.Point to the picture you want to move.
3.Drag the Hand tool to bring the area of the picture into view.
· Use the Locator tool to display the same area in duplicated windows of different 

magnification.



Locator tool -- Viewing the same area in multiple windows
To locate the same area of a picture in two or more windows:
· Click on the area in one picture to show that area in other duplicated pictures that are 

displayed at different magnifications.



Eyedropper tool -- Picking up a color from the screen
To pick up a color from the screen with the Eyedropper tool:
1.Click the Eyedropper tool.
2.Point to the color you want to pick up from your picture.
3.Click the left mouse button to choose the outline color, or the right mouse button to 

choose the fill color, or hold down Ctrl and click the left or right mouse button to choose 
the background color.

4.Choose a tool or command to use with the color you pick up.



Rectangle Selection tool -- Defining a rectangular area
Use the right mouse button with the Rectangle Selection tool to select an area and leave the
background area unaltered when you move the cutout.
Use the left mouse button with the Rectangle Selection tool to select an area and cut it from 
the background area when you move it.

To define a cutout with the Rectangle Selection tool:
1.Click the Rectangle Selection tool.
2.Press the left or right mouse button to anchor the starting point.
3.Drag to surround the area you want. 
4.Release the mouse button to complete the cutout.
5.Click and drag on the selection to move a copy of the selection to another location in the 

image.



Lasso tool -- Defining an irregular area
The Lasso tool has two modes of operation. One mode allows you to outline an area with the
lasso and manipulate that exact area. In the other mode, you outline an area with the Lasso 
tool, and the Lasso will only cutout (or snap to) areas without the background color. Press 
the L key to toggle between the two modes.
Use the right mouse button with the Lasso tool to select an area and leave the background 
area unaltered when you move the cutout.
Use the left mouse button with the Lasso tool to select an area and cut it from the 
background area when you move it.

To define a cutout with the Lasso tool:
1.Click the Lasso tool.
2.Press the left or right mouse button to anchor the starting point.
3.Drag to surround the area you want to define.
4.Release the mouse button to complete the cutout.
5.Click and drag on the selection to move a copy of the selection to another location in the 

image.



Polygon Selection tool -- Defining a polygonal area
Use the right mouse button with the Polygon Selection tool to select an area and leave the 
background area unaltered when you move the cutout.
Use the left mouse button with the Polygon Selection tool to select an area and cut it from 
the background area when you move it.

To define a cutout with the Polygon Selection tool:
1.Click the Polygon Selection tool.
2.Click the left or right mouse button to anchor the starting point.
3.Move to the next point and click. Continue clicking around the area you want to define. 
4.Double-click to end the last line and complete the cutout.
5.Click and drag on the selection to move a copy of the selection to another location in the 

image.



Magic Wand tool -- Defining areas with similar colors
Use the right mouse button with the Magic Wand tool to select an area and leave the 
background area unaltered when you move the cutout.
Use the left mouse button with the Magic Wand tool to select an area and cut it from the 
background area when you move it.

To define an area with the Magic Wand tool:
1.Choose Color Tolerance to specify the range of colors for selection.
2.Click the Magic Wand tool.
3.Point to the area you want to select and click the left or right mouse button.



Manipulating defined areas
Use a selection tool to surround the selected area (a cutout) with a marquee.
You can manipulate cutouts in the following ways:
· Use the right mouse button with a selection tool to select an area and leave the 

background area unaltered when you move the cutout.
· Use the left mouse button with a selection tool to select an area and cut it from the 

background area when you move it.
· Point inside the cutout and drag to move the cutout to another location.
· You can use the arrow keys to move the cutout one pixel at a time.
· Choose a command from the Image and Effects menus to manipulate the cutout in other 

ways. For example, you can apply filters to the cutout, or flip, invert, outline, rotate, or 
distort the cutout.



Local Undo tool -- Undoing some changes
To undo some changes:
1.Click the Local Undo tool.
2.Adjust the tool's width and shape in the Tool Settings Roll-Up located in the Display menu.
3.Drag over areas you want to return to their last previous look.

Related Topics
Color Replacer
Eraser
Undo



 Eraser tool -- Erasing parts of your picture
To use the Eraser tool:
1.Click the Eraser tool.
2.Choose a background color. The Eraser changes parts of your picture to the background 

color.
3.Adjust the tool's width and shape in the Tool Settings Roll-Up located in the Display menu.
4.Drag over areas you want to erase.



Text tool -- Adding text to your picture 
To add text to your picture:
1.Choose an outline color for your text from the Color Selection Roll-Up located in the 

Display menu.
2.Click the Text tool. The Enter Text dialog box is displayed. 
3.Click inside the text box area. You can enter approximately 1250 characters of text. 
· Press Ctrl+Enter to start a new line.
· Press Shift+Ins to insert text from the clipboard.
4.Choose a font from the Font list as well as a font style from the Font Style list. A sample 

is displayed.    Choose the font Size as well as Effects such as strikeout or underline.
5.Click OK.
· The text appears in your picture surrounded by marquee.
· Drag the handles on the marquee to adjust your margins.
· Click inside the marquee and drag it to move your text to another location before you 

paste it.
· Press Esc or the Spacebar to return to the EnterText dialog box if necessary.
· Choose a different color if you want to change the color of your text.
6.Make final changes to your text before you paste it.
7.Click outside the marquee area or choose another tool to paste the text.



 Fill tool -- Filling an area with color
To fill an area with color:
1.Click the Fill tool.
2.Choose a fill or outline color from the Color Selection Roll-Up located in the Display menu.
3.Choose Color Tolerance to adjust the range of colors to fill.
4.Place the pointer on the area you want to fill. If color leaks out, choose Undo and zoom in 

to patch the border with the Pen tool. You may have to adjust color tolerance to control 
leaking.

5.Click the left mouse button to use the fill color, or click the right mouse button to use the 
outline color.



Spraycan tool -- Splattering color with the spraycan
To use the Spraycan:
1.Click the Spraycan tool.
2.Choose an outline or fill color from the Color Selection Roll-Up located in the Display menu.
3.Adjust the tool's width and shape in the Tool Settings Roll-Up located in the Display menu.
4.Point to the area you want to splatter.
5.Click and drag with the left mouse button to paint with the outline color, or click and drag 

with the right mouse button to paint with the fill color.



Airbrush tool -- Shading with the airbrush
To use the Airbrush tool:
1.Click the Airbrush tool.
2.Choose an outline or fill color from the Color Selection Roll-Up located in the Display menu.
3.Adjust the tool's width and shape in the Tool Settings Roll-Up located in the Display menu.
4.Point to the area you want to airbrush.
5.Click and drag with the left mouse button to paint with the outline color, or click and drag 

with the right mouse button to paint with the fill color.



 Paint Brush tool -- Painting
To use the Paint Brush tool:
1.Click the Paint Brush tool.
2.Choose an outline color from the Color Selection Roll-Up located in the Display menu.
3.Adjust the tool's width, shape, edge, density, transparency, fade out, and spacing in the 

Tool Settings Roll-Up located in the Display menu.
4.Point to where you want to start.
5.Drag to paint.



 Artist Brush tool --    Painting
Each brush stroke is a 64 pixel wide by 128 pixel high grayscale bitmap (Windows BMP file), 
where the black area constitutes the transparent part, the mid-grays are the brush stroke 
and the white represents the overexposed areas of the stroke.

To use the Artist Brush tool:
1.Choose an outline color from the Color Selection Roll-Up located in the Display menu.
2.Choose a brush style from the Tool Settings Roll-Up located in the Display menu. Click a 

brush name or click again on the same name to see if there are more styles available for 
that brush name.

3.Adjust the tool's width in the Tool Settings Roll-Up.
4.Point to where you want to start.
5.Drag to paint.
To add a new artist brush:
1.Copy an existing set to a new name (for example, MyNewBrush, made up of three brush 

strokes: MYBRUSH1.BMP, MYBRUSH2.BMP, and MYBRUSH3.BMP).
2.  Start with Oil1.    This brush uses 5 bitmapped strokes: OIL_A1.BMP through OIL_A5.BMP.
3.  Copy OIL_A1.BMP to MYBRUSH1.BMP.
4.  Open MYBRUSH1.BMP and design your own brush.    (You might want to try scanning a 

realistic image and retouching it. Then save it as MYBRUSH1.BMP.)
5.  Duplicate MYBRUSH1.BMP to get more variation of the same brush. After you duplicate it, 

retouch the duplicated file and then save the altered image with a new name, such as 
MYBRUSH2.BMP or MYBRUSH3.BMP. You may have up to 5 different brush strokes per 
pack.    These must all be saved in the \PHOTOPNT\BRUSHES directory.

6.  Edit CORELPNT.INI in the CONFIG directory, by adding something similar to the line below 
beginning with Pack9= :

[ARTIST]

NumBrushPacks=9
CurrentPack=1
Path=C:\COREL40\PHOTOPNT\BRUSHES
Pack1=Oil1,5,OIL_A1.BMP,OIL_A2.BMP,OIL_A3.BMP,OIL_A4.BMP,OIL_A5.BMP
...    ...    ...
...    ...    ...
Pack8=Oil8,1,OIL_H.BMP
Pack9=MyNewBrush,3,MYBRUSH1.BMP,MYBRUSH2.BMP,MYBRUSH3.BMP
Notes:
NumBrushPacks = 9

This is the total number of brushes, in this section (9 brushes maximum, labelled Pack1 to Pack9)
Path=C:\COREL40\PHOTOPNT\BRUSHES

This line points to the brushes directory on your system. Your path may differ from this.
Pack9=MyNewBrush,3,MYBRUSH1.BMP,MYBRUSH2.BMP,MYBRUSH3.BMP

This line defines your new brush, and "MyNewBrush" will show as the brush name in the Tool Settings Roll-Up. 
The "3" here is the number of BMP's representing the three different strokes. Note that the digit following "Pack" 
determines in which order the brushes are displayed in the roll-up list box.

Exit and restart CorelPHOTO-PAINT for these changes to become effective.



Pen tool -- Drawing shapes
To use the Pen tool:
1.Click the Pen tool.
2.Choose an outline color from the Color Selection Roll-Up located in the Display menu. Or 

you can click the right mouse button on a color in your picture to choose it as the outline 
color.

3.Adjust the tool's width and shape in the Tool Settings Roll-Up.
4.Drag to draw the shape that you want. Hold down Ctrl while you drag to constrain the tool 

vertically or horizontally. Press the spacebar to change the direction of the constraint.
· Use the Pen tool for pixel by pixel editing when in maximum zoom mode (1600 %).



Color Replacer tool -- Replacing the outline color with the fill color
To replace colors:
1.Click the Color replacer tool.
2.From the Color Selection Roll-Up, choose an outline color (the color you want to change) 

and a fill color (the color you want the Color Replacer to use).
3.Adjust the tool's width and shape in the Tool Settings Roll-Up.
4.Choose Color Tolerance to adjust the range of colors to replace.
5.Drag over areas you want to change. Hold down Ctrl while you drag to constrain the tool 

vertically or horizontally. Press the spacebar to change the direction of the constraint.



Curve tool -- Drawing single and joined curves
To draw a curve:
1.Click the Curve tool.
2.Choose an outline color from the Color Selection Roll-Up.
3.Adjust the tool's width and shape in the Tool Settings Roll-Up.
4.Press the left mouse button to anchor the starting point.
5.Drag to where you want the curve to end.
6.Click and drag the circles and square handles to adjust the curve.
7.Press Esc before releasing the mouse button to start over.
8.Click with the left mouse button outside the curve, or choose another tool to paste the 

curve.
To draw joined curves:
1.Repeat the above steps but do not paste the curve.
2.Point to where you want the adjoining curve to end.
3.Click the right mouse button.
4.Adjust the curve.
To draw curves joined at a single starting point:
1.Repeat the steps for drawing a single curve but do not paste it.
2.Point to where you want the second curve to end.
3.Press and hold Ctrl and click the right mouse button.
4.Adjust the curve.



Line tool -- Drawing single and joined Lines
To draw a line:
1.Click the Line tool.
2.Choose an outline color from the Color Selection Roll-Up.
3.Adjust the tool's width and shape in the Tool Settings Roll-Up.
4.Press the left mouse button to anchor the starting point.
5.Drag to where you want to end the line and release the mouse button. Press Esc before 

releasing the mouse button if you want to start over.
To draw joined lines:
1.Repeat the above steps.
2.Point to where you want the adjoining line to end.
3.Click the right mouse button.
To draw rays joined at a single starting point:
1.Repeat the steps for drawing a single line.
2.Point to where you want the second line to end.
3.Press and hold Ctrl and click the right mouse button.



Hollow / Filled Box tool -- Drawing a hollow or filled box
To draw a hollow / filled box:
1.Click the Hollow or Filled Box tool.
2.From the Color Selection Roll-Up choose an outline color for the border and fill color for the

fill if applicable.
3.Adjust the width of the border in the Tool Settings Roll-Up.
4.Press the left mouse button to anchor the starting point.
5.Drag to draw the shape (hold down Ctrl to constrain the shape to a square).



Hollow / Filled    Rounded Box tool -- Drawing a hollow or filled 
rounded box
To draw a hollow / filled rounded box:
1.Click the Hollow or Filled Rounded Box tool.
2.From the Color Selection Roll-Up choose an outline color for the border and fill color for the

fill if applicable.
3.Adjust the width of the border in the Tool Settings Roll-Up.
4.Press the left mouse button to anchor the starting point.
5.Drag to draw the shape (hold down Ctrl to constrain the shape to a square).



Hollow / Filled Ellipse tool -- Drawing a hollow or filled ellipse
To draw a hollow or filled ellipse:
1.Click the Hollow or Filled Ellipse tool.
2.From the Color Selection Roll-Up choose an outline color for the border and fill color for the

fill if applicable.
3.Adjust the width of the border in the Tool Settings Roll-Up.
4.Press the left mouse button to anchor the center point.
5.Drag to draw the shape (hold down Ctrl to constrain the shape to a circle).



 Hollow / Filled Polygon tool -- Drawing a hollow or filled polygon
To draw a hollow or filled polygon:
1.Click the Hollow or Filled Polygon tool.
2.From the Color Selection Roll-Up choose an outline color for the border and fill color for the

fill if applicable.
3.Adjust the width of the border in the Tool Settings Roll-Up.
4.Click the mouse button to anchor the starting point.
5.Move to where the next side should end and click. Continue moving and clicking to draw 

the shape (hold down Ctrl to constrain each line vertically, horizontally, or diagonally).
6.Double-click to end the last line and complete the shape.



Clone tool -- Replacing one area with another 
To use the Clone tool:
1.Click the Clone tool.
2.Adjust the tool's width, shape and effect in the Tool Settings Roll-Up.
3.Click the right mouse button on the area you want to clone (source). This defines the 

center of the area. To change the center, click another location. Cloning gives you more 
control than copying or pasting.

4.Move to the spot you want to start painting on and click and drag with the left mouse 
button. No cloning occurs after you reach the edges of your source picture. 



Impressionist Clone tool    
To use the Impressionist clone tool:
1.Click the Impressionist Clone tool.
2.Adjust the tool's width, shape and effect in the Tool Settings Roll-Up.
3.Click the right mouse button on the area you want to clone (source). This defines the 

center of the area. To change the center, click another location. 
4.Drag to begin cloning. The brush strokes will use the colors from the cloned area.



Pointillist Clone tool 
To use the Pointillist Clone tool:
1.Click the Pointillist Clone tool.
2.Adjust the tool's width, shape and effect in the Tool Settings Roll-Up.
3.Click the right mouse button on the area you want to clone (source). This defines the 

center of the area. To change the center, click another location. 
4.Drag to begin cloning with dots made up of colors from the cloned area. 



Impressionist Brush tool -- Impressionist painting 
To use the Impressionist Brush tool:
1.Click the Impressionist Brush tool.
2.Adjust the tool's width, shape and effect in the Tool Settings Roll-Up.
3.Drag the brush over an area you want to paint.
4.The area will be filled with brush strokes that reflect the type of settings specified in the 

roll-up.



 Pointillist Brush tool -- Pointillist painting
To use the Pointillist Brush tool:
1.Click the Pointillist Brush tool.
2.Adjust the tool's width, shape and effect in the Tool Settings Roll-Up.
3.Drag the brush over an area you want to paint.
4.The area will be filled with dots.



Freehand Blend tool
To blend areas:
1.Click the Freehand Blend tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Drag the arrow    or enter a number to specify the amount of blending.
4.Drag over areas you want to change.



Freehand Brighten tool 
To brighten areas:
1.Click the Freehand Brighten tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Drag the arrow or enter a number to specify brightness.
4.Drag over areas you want to change.



Freehand Contrast tool
To adjust contrast in areas:
1.Click the Freehand Contrast tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Drag the arrow or enter a number to specify the amount of contrast.
4.Drag over areas you want to change.



Gradient Fill tool
The Gradient Fill tool fills an area with a horizontal, vertical, or radial color wash.

To fill an area with a gradient:
1.Click the Gradient Fill tool.
2.Choose a To and From color from the Color Selection Roll-Up.
3.Choose a gradient type from the Fill Settings Roll_Up in the Display menu and adjust 

Balance.
4.Choose Color Tolerance to adjust the range of colors to replace with the fill.
5.Place the pointer inside the area you want to fill, and click.



Freehand Smear tool
Use the Smear tool to spread colors in a picture. The effect is similar to smearing oil paints.

To smear areas:
1.Click the Freehand Smear tool.
2.Adjust the tool's width, shape and brush settings in the Tool Settings Roll-Up.
3.Drag over the areas you want to change.



Freehand Smudge tool
Use the Smudge tool to add texture by randomly mixing dots in a selected area.

To smudge areas:
1.Click the Freehand Smudge tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Drag over the areas you want to change.



Tile Fill tool
To fill an area with a tile pattern:
1.Click the Tile Fill tool.
2.Choose a tile pattern with the Fill Settings Roll-Up in the Display menu.
3.Choose Color Tolerance to adjust the range of colors to fill.
4.Place the pointer inside the area you want to fill.
5.Click the left mouse button to fill the area.



Texture Fill tool
Bitmap textures are fills that look like clouds, water, gravel, minerals and dozens of other 
natural and man-made substances. Each texture has a set of parameters that you can 
change to create millions of variations.

To fill an area with a bitmap texture:
1.Click the Texture Fill tool.
2.Choose Color Tolerance if required to adjust the range of colors to fill.
3.Click Create Texture in the Fill Settings Roll-Up in the Display menu.
4.Choose a texture from the Texture Fill dialog box.
5.Place the pointer inside the area to fill.
6.Click the left mouse button to fill the area.



Freehand Tint tool
To tint areas:
1.Click the Freehand Tint tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Choose an outline color in the Color Selection Roll-Up located in the Display menu. 
4.Drag over the areas you want to change.



Freehand Sharpen tool 
To sharpen areas:
1.Click the Freehand Sharpen tool.
2.Adjust the tool's size and shape in the Tool Settings Roll-Up.
3.Drag the arrow or enter a number to specify the amount of sharpening.
4.Drag over the areas you want to change.



Texture Fill dialog box
Use this dialog box to select one of the 100 plus bitmap texture fills included in CorelPHOTO-
PAINT. Each texture has a set of parameters that you can change to create millions of 
variations.
· The textures look best on color monitors. If you are using a monochrome monitor, you may

not get a very good representation of the texture's appearance.

Dialog Options

Texture Library
Textures in the Styles Library can also be altered and saved. When you save them, however, 
you must store them in another library. You cannot save modified textures to the Styles 
Library.

Texture List
Displays textures in the selected library. Click the one you want.

Preview
Varies the appearance of the selected texture by randomly changing all unlocked 
parameters. You lock and unlock parameters by clicking the Lock icon next to it.
You also use the Preview button to update a texture after changing the parameters yourself.

Save
After changing the parameters of a texture in the library (or a new library you created) 
choose save to overwrite the original.

Save As
Opens a dialog box for naming (or renaming) a texture you've created. The Texture Name 
can be up to 32 characters (including spaces). The    Library Name allows you to create a 
new library in which to store the textures you create. You can type up to 32 characters 
(including spaces). The Library List displays libraries where you can store the modified 
texture in.
NOTE: You must save modified Style textures in a library you create.

Delete
Deletes the selected texture. You can only delete textures from libraries you create.

Style Name <name>
Lists parameters for the selected texture. Changing one or more of these parameters alters 
the appearance of the texture.
The left side of the Style Name field lists up to six numeric parameters. All textures have a 
Texture Number parameter which ranges from 0 to 32,768. The names of the other 
parameters vary with the texture and have a range from 0 to 100 or -100 to 100.
To change a numeric parameter, enter a value in the text box and click the Preview button.
The right side of the field lists up to six color parameters. To change a color, click on the 
color button and select a new one from the pop-up palette. Click the More button if you want
to create a color or choose it by name. To see the effect the new color has on the texture, 
click the Preview button.



Display menu
Zoom Magnifies or shrinks the active picture. Choose the Zoom percentage 

you want from the drop-down list. If you magnify by 1600%, 
CorelPHOTO-PAINT displays a grid that shows individual pixels. The 
Zoom tool also allows you to magnify an image.

100% (No Zoom) Returns a picture to one-to-one view. Double click the Zoom tool to 
quickly return to the 100% view.

Zoom To Fit Shrinks or magnifies your picture to fit your CorelPHOTO-PAINT 
desktop.

Hide/Show All Hide or show all roll-ups, and the tool box.
Toolbox Allows you to display the Toolbox or to remove it from the work area.
Canvas Roll-Up Allows you to load canvas patterns.
Color Selection Roll-Up Allows you to choose colors, and specify To and From colors for 

gradients.
Fill Settings Roll-Up Controls access to tile patterns, textures, and gradient settings.
Tool Settings Roll-Up Controls tool shape, width, and characteristics. 
Maximize Work Area Removes the title bar and menu bar from your screen and 

maximizes your desktop. You can edit a picture in this mode. Click the 
Minimize button to return to normal view.

Full Screen Preview Removes everything but the active picture from your screen. 
You cannot edit a picture in Full Screen Preview mode. Press Esc to 
return to normal view.

Optimized Dithering Improves the on-screen look of your pictures if they contain 
more colors than your monitor supports.

Calibrate Use the Display Calibration dialog box to calibrate your monitor. 



Canvas Roll-Up (Display menu)
Use the Canvas Roll-Up to apply any tile pattern as your painting background. The canvas 
can also be used with a high transparency percentage to overlay an existing picture.
A Canvas can be any color (mono or grayscale images have to be converted to color first) 
square image with the following sizes: 16x16, 32x32, 48x48, 64x64, 80x80, 96x96, 112x112
and 128x128 pixels. For better results in applying a Canvas, its colors should be centered in 
the mid-tones. Use the Equalize command (from the Tone option in the Image menu) to view
and adjust the histogram of the Canvas.

To use the Canvas Roll-Up:
1.Click the Load button to select a canvas from a directory. Enter a Transparency value (the 

higher the percentage, the more transparent the overlay). To create an embossed effect 
on the canvas, enter a percentage value in the Emboss box. This will give a raised relief 
effect to the canvas.

2.Click the Apply button to apply the canvas to form the painting background for a new 
picture.    Once applied, the canvas will show through any future paint application.

3. Click the Merge button if you are using the canvas as an overlay. This will combine 
the canvas with the picture into one image. With Merge, the canvas will be painted over 
by any future paint process. An applied canvas will not be saved with the image until it 
has been merged.

To build a new canvas:
1.Open an existing canvas as a normal image. 
2.Clear it, then edit it or use the Paste From command to copy any image you want. 
3.Save the canvas with a new name.



Color Selection Roll-Up (Display menu)
Use the Color Selection Roll-Up to choose outline, fill, and background colors. As well, use 
the To and From buttons to select a color range for the Gradient Fill tool. These buttons are 
only displayed after you click the Gradient Fill tool. Click the small black arrows to display 
different areas of the roll-up.

Fill / Outline / Backgound Button
Click this button then select a color from the color table or enter color values in the 
boxes. Click a color model such as RGB, to allow you to choose colors from the color 
cube / circle by clicking over the color you want. 

Pick / Edit button
Click and drag the colors in the Paint Area to mix a new color. Click the color and drag
it to the Color Table.

Load Colors
 allows you to open a previously saved Color Table.

Save Colors
 allows you to save a Color Table with a new name.

Clear Paint Area
clears the area to the background color.

Specify your choice of color models by clicking one of the following:
RGB Red, green, and blue color model.
CMYK Cyan, magenta, yellow, and black process color model.
HSB Hue, saturation, and brightness color model.
Image Palette colors from the current image.
Standard Palette default group of colors, also used as a dithering table for 8-bit displays.



Fill Settings Roll-Up    (Display menu)
The Fill Settings Roll-Up allows you to use a previously saved pattern as the fill for the Tile Fill
tool. Bitmap textures can be loaded for use with the Texture Fill tool. When the Gradient Fill 
tool is active, the Fill Settings Roll-Up displays gradient types and the balance control.

To use the Fill Settings Roll-Up with the Tile Fill tool:
1.Click the Tile Fill tool.
2.Click the Load Tile button on the Fill Settings Roll-Up.
3.Choose a file from a directory.
4.Click OK. 
To use the Fill Settings Roll-Up with the Texture Fill tool:
1.Click the Texture Fill tool.
2.Click the Create Texture button on the Fill Settings Roll-Up.
3.Choose a bitmap texture from the Texture Fill dialog box.
4.Click OK. 
To use the Fill Settings Roll-Up with the Gradient Fill tool:
1.Click the Gradient Fill tool.
2.Choose the To and From colors in the Color Selection Roll-Up.
3.Choose a vertical, horizontal, or radial gradient type from the Fill Settings Roll-Up.
4.Click and drag the balance control.
5.Fill the area with the Gradient Fill tool. 



Tool Settings Roll-Up    (Display menu)
The Tool Settings Roll-Up allows you to change the shape and size of brushes / tools; their 
effects; and the variance and number of lines for the Impressionist Brush, Pointillist Brush, 
Impressionist Clone, and the Pointillist Clone. The settings are specific to the selected tool. 
This allows you to alternate between tools without changing settings. When the Artist Brush 
is active, the roll-up displays a list of different brush strokes.

Tool Settings Roll-Up options:
Width and Shape click and select the shape for the tool, and enter a value for the width.
Edge adjusts the edge (soft, medium, hard) of the paint stroke. 
Density adjusts the overall softness of the paint stroke (100 = bolder, thicker).
Transparency the higher the number, the more transparency.
Fade out adjusts the rate at which the stroke disappears. A higher number 

creates more fade out.
Spacing adjusts the distance between sections of each stroke. At 0, the spacing 

depends upon the speed at which you drag the mouse. A low value 
creates close strokes. Use a value of 1 for smooth continuous strokes.

Hue variance varies the amount of hue (shade of a particular color).
Saturation variance varies the amount of saturation (how much of a particular color).
Luminance variance varies the amount of lightness.
Width variance sets a distance between strokes with the Impressionist tools and 

Pointillist tools.
Number of lines sets the number of lines or dots used with the Impressionist tools and 

Pointillist tools.



Calibrate    (Display menu)
Use the Calibrate command to improve / optimize the linearity of your monitor so that 
pictures appear as similar on-screen as possible, in comparison to a white-balanced 
photograph. Gradations in color in the color bar at the bottom of the dialog box should 
become more uniform as you change values in the Relative Intensity boxes.
Adjust values in the Color Balance boxes to remove any tints from the vertical strip. This 
allows you to adjust for differences in color shift among monitors.
Enter a Gamma value in the box.
Save your custom calibration curve, or load in different curves for different monitors.



Control Menu
Use Control menu commands on the CorelPHOTO-PAINT program and picture windows to 
move, close, restore, and change the size of the window. A picture window Control menu 
also contains the Image Info command.

Restore returns the active window to its former size and location.
Move allows you to use the keyboard to move the active window.
Size allows you to use the keyboard to resize the active window.
Minimize shrinks the active window to an icon.
Maximize enlarges the active window to fill the screen.
Close closes the active window.
Switch To lets you switch among currently open applications.



Restore command (Control menu)
Returns the CorelPHOTO-PAINT or Help window to the size and location it had before you chose the 
Control Minimize or the Control Maximize command.

You can also restore a window by clicking on its Restore button

· Does not affect a window moved or resized with the Control Move or Control Size 
commands.



Move command (Control menu)
Use to move the CorelPHOTO-PAINT or Help window with the Direction keys on the keyboard. 

· This command is unavailable if the window is maximized.
· You can use this command to move Application icons and dialog boxes that have a Control 

menu.

For more information, see your Microsoft Windows User's Guide.



Size command (Control menu)
Use to resize the CorelPHOTO-PAINT or Help window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.

For more information see your Microsoft Windows User's Guide.



Minimize command (Control menu)
Shrinks the CorelPHOTO-PAINT or Help window to a small icon at the bottom of the screen.

· Using the Control Minimize command is equivalent to clicking on the Minimize button with 
the mouse.

· You can use the Control Restore command to restore the minimized window to its former 
size.



Maximize command (Control menu)
Expands the CorelPHOTO-PAINT or Help window to fill the entire screen.

· Using the Control Maximize command is equivalent to clicking on the Maximize icon with 
the mouse. 

· You can choose the Control Restore command or click on the Restore icon to return the 
window to its former size.



Close command (Control menu)
Closes the CorelPHOTO-PAINT or Help window. 
· Closing CorelPHOTO-PAINT is the same as choosing Exit.

· Double-clicking on the Control Menu icon  is equivalent to choosing the Control Close 
command. 



Switch To command (Control menu)
Opens the Task List which lists all the applications currently running on your system.

Dialog Box Options
Switch To Opens the selected application.
End Task Closes the selected application.
Cancel Closes the Task List.
Cascade Overlaps all open applications so that their Title bars are visible.
Tile Sizes all open applications to fit on the screen.
Arrange Icons Arranges the icons of all minimized applications evenly across 

the bottom of the screen. 



Maximize button
Clicking on the Maximize button expands the active window to fill the entire screen. After you expand a 
window, the button changes to the Restore button . Use the Restore button to return the window to its 
former size.

· You can also maximize a window by choosing the Control Maximize command.
· You can also restore a maximized window to its former size by choosing the Control 

Restore command.



Minimize button
Clicking on the Minimize button shrinks the window to an icon at the bottom of the screen.

· As an icon, CorelPHOTO-PAINT stays in memory, but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon or click once on the icon and choose Control
Restore.



Restore button 
Restores a window enlarged with the Maximize button or the Control Maximize command to its previous 
size and location.

· You can also restore a window by choosing the Control Restore command.
· Does not affect a window moved or resized with the Control Move or Control Size 

commands.



Control menu
A menu available in all Windows applications. Used to move, resize, minimize, maximize and
close applications. Pressing the Alt key and spacebar or clicking on icon at the left of title bar
opens the Control menu. 



Control menu box
Icon on the left of a window's title bar which opens the Control menu. 



Maximize
To enlarge an application window to full screen size.



Working with windows
Editing your picture full screen
Viewing a picture in multiple views
Viewing only your picture
Viewing the same area in multiple windows
Pasting from disk
Pasting from the Clipboard
Saving portions of your picture to disk
Using Ccapture



Using selection tools
Defining a polygonal area
Defining a rectangular area
Defining an irregular area
Defining areas with similar colors



Display tools
Moving areas of your picture into view
Zooming in and out with the zoom commands
Zooming in and out with the Zoom tool
Zooming to fit



Using painting tools
Adjusting tool settings
Using the paintbrush
Filling an area with a gradient
Filling an area with a tile pattern
Filling an area with color
Filling an area with a texture
Picking up a color from the screen
Replacing one area with another (cloning)
Replacing one color with another
Shading with the airbrush
Smearing colors 
Smudging colors
Splattering color with the spraycan



Using drawing tools
Drawing a filled or hollow rectangle
Drawing a filled or hollow ellipse/circle
Drawing a filled or hollow polygon
Drawing a filled or holow rounded rectangle
Drawing shapes
Drawing single and joined curves
Drawing single and joined lines



Retouching pictures
Adding text
Adding texture to your picture
Using the blend tool
Using the blend filter
Using the brighten tool
Changing contrast 
Changing highlights and shadows
Creating a motion effect
Diffusing a picture
Embossing a picture
Enhancing edges
Erasing portions of a picture
Fine-tuning with the color/gray map filter
Flipping, rotating and resizing
Inverting colors
Undoing changes to a picture
Undoing only specific changes
Pixelating a picture
Sharpening
Using the sharpen filter
Smearing colors
Smudging colors
Tinting



Working with colors
Adjusting on-screen brightness
Changing color formats
Using the Color Selection Roll-Up
Inverting colors
Picking up a color from the screen
Replacing one color with another
Specifying color tolerance
Viewing colors on screen



Working with files
Creating a new picture
Displaying picture information
Loading a tile pattern
Opening an existing picture
Saving a picture with a new name



Viewing colors on your screen
CorelPHOTO-PAINT provides device independence so you can load and edit images that have
more colors than your monitor supports. CorelPHOTO-PAINT simulates colors not supported 
by your monitor and retains all the original details and colors in your picture.
· To adjust how bright your pictures appear on-screen, use the Calibrate command in the 

Display menu. 
· To enhance how simulated colors appear on-screen, use Optimize Dithering in the Display 

menu.



CCapture Utility
CorelPHOTO-PAINT has a screen capture utility you can use to capture areas of your screen.
CCapture takes over your Windows screen capture functions so you can capture all or part of
your screen and keep your colors intact.

To run CCapture:
1.Open your Windows Program Manager.
2.Double-click the CCapture icon. An information box appears on your screen explaining 

CCapture.
3.Click the left mouse button again to remove the information box.
4.To disable CCapture and use the standard Windows screen capture functions, double-click 

the CCapture icon again.
To copy areas to the Windows clipboard with CCapture:
Press PrtSc to capture the entire desktop.
Press Alt+PrtSc to capture only the active window.
Press Alt+Pause to capture only the contents of the active window. If your keyboard does not
include a Pause key, press Alt+Ctrl+NumLock.
To disable CCapture and use the standard Windows screen capture functions, double-click 
the CCapture icon again.

To display in CorelPHOTO-PAINT the area you copied to the Windows clipboard:
Choose Paste as new selection, or Paste as new image from the Edit menu.



Mask menu
Masks are used to protect the background picture from changes that are made to a selected 
area. Various filters and enhancements can be applied to the image areas that have been 
masked.
Select All Selects the entire image as a mask.
Clear Mask Clears the mask marquee from a selected area.
Crop to Mask Creates a new file from the masked selection.



The Special menu
Color Tolerance Adjusts the color comparison tolerance.
Preferences Adjusts settings for program startup, and units of measure.
System Info Displays information about the current picture, the display, and the 

hardware configuration.



Color Tolerance (Special menu)
Use the Color Tolerance command with the fill tools and the Magic Wand tool. The color 
tolerance values represent a range of colors that are to be replaced by a single fill. A higher 
number means that more colors will be replaced by a single fill. The plus and minus values 
displayed in the dialog box indicate the range of color values from 0 to 255 that represent 
brighter and darker shades of each primary color. The values take effect the next time you 
use a fill tool or the Magic Wand.

To specify a range of similar colors to fill, replace, or select:
1.Enter or select a color tolerance range for red, green and blue. Click Identical Values if 

you want to to set all the ranges to the same values.
2.Click OK.



System Info (Special menu)
Use System Info to display information about your current picture, screen, printer, and 
computer memory. 
Image Displays the resolution, size, and number of colors in your picture.
Screen Displays the number of dots per inch your screen can display. The 

higher the number, the sharper your display. The number of colors that
can be displayed is indictated.

Printer Displays the name of the currently selected printer and the dots per 
inch that the printer can print. The higher the number, the sharper 
your printout will be.

Computer Memory Displays how much memory and disk space is installed in the computer
and how much is unused. 



Window menu
Cascade Layers CorelPHOTO-PAINT picture windows so each title bar is visible. 

To activate a picture click the title bar of the picture.
Tile Arranges CorelPHOTO-PAINT picture windows in equal sizes to fit on 

your screen.
Arrange Icons Arranges minimized pictures across the bottom of the CorelPHOTO-

PAINT desktop.
Duplicate Duplicates the current picture. Use the Locator tool to navigate among 

duplicate pictures of different magnification.      




